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Introducing CorelDRAW® Technical Suite 2018

CorelDRAW® Technical Suite 2018 empowers visually
impactful technical communication. The suite lets
users work more efficiently and precisely thanks to a
comprehensive collection of applications, innovative
tools, and accelerated application performance.
Technical communication professionals and technical
graphics users can adapt and customize their design
space to match their workflow needs and achieve
unsurpassed productivity with new, high-caliber
features. The suite ensures that users can make the
most of a wide range of content by repurposing it

) Corel DESIGNER 2018 (64-Hit) - Symmetry.des”

from existing sources and get full support for technical
standards to publish, share or print.

Precise

Corel DESIGNER 2018 lets technical illustrators apply
exacting specifications using dedicated tools to design
visually detailed assembly instructions, complex user
manuals and multi-faceted documentation. Then,
technical designs can be efficiently leveraged to
deliver multi-lingual technical communication with
Translation Memory System (TMS) support.
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Comprehensive

The suite delivers an array of professional applications
that cover all aspects of visual communication
authoring, project creation and publishing of technical
documentation. Whether you need impressive photo-
editing capabilities, innovative design tools, or a 3D
visualization application for outputting 3D files,
CorelDRAW Technical Suite 2018 has you covered. The
integrated workflow provides a seamless experience,
from opening source files, such as 2D, 3D, photo,
documents and data, to supporting output for print,
online and mobile.

The industry-leading file format compatibility of
CorelDRAW Technical Suite 2018 ensures that technical
graphics professionals can access critical data from
various sources and deliver technical files in a readable
format. You can export to over 100 file formats, so you
can exchange files with colleagues and clients
worldwide and produce a range of downstream
outputs, including 3D PDF.

You can also rely on compliance with various
standards-based systems thanks to support for
technical publication standards, including WebCGM,
S1000D, ATA iSpec 2200, SVG and PDF. Collaborating
with colleagues has never been easier thanks to
support for Microsoft SharePoint. You can also count
on hassle-free file sharing with co-workers and clients
alike. Whether it's AutoCAD® DWG and DXF, Adobe®
lllustrator® CS/CC, Adobe® Photoshop® CS/CC,
Microsoft® Publisher, or Adobe® Acrobat®, you can
access and repurpose data from a wide range of
formats.

Innovative

CorelDRAW Technical Suite 2018 has new design tools
that you just can't find anywhere else. Whether it's the
groundbreaking new Symmetry drawing mode or the
enhanced LiveSketch™ tool, you can take your
technical authoring expertise to the next level. State-
of-the-art image-editing and design tools simplify the
creation of marketing collateral, graphics, and
presentation materials.

What's more, this release offers faster processing and
supports new hardware, OS capabilities, and the latest
updates for Windows 10.
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Choose your purchase option

In the interest of user choice, there are several
CorelDRAW Technical Suite purchase options.

Perpetual License

At Corel, we strongly believe that you should not be
forced into a rental model if you don’t want it. For a
onetime payment, a CorelDRAW perpetual license
gives you the right to use the software forever, with no
extra monthly cost. By purchasing a box, download
version or volume license version of the product, you
get access to the full benefits of a specific version, and
there is no need for a permanent Internet connection.
With the optional Upgrade Protection Program
customers can additionally benefit from receiving
major version upgrades immediately when they
become available. There is also a volume licensing
option for companies with five or more seats — the
CorelDRAW Technical Suite Enterprise license. It
includes one-year CorelSure Maintenance, which
offers efficient multilingual software deployment and
virtualization support. It also has downgrade rights,
which cover the use of previous version with newly
added licenses.

Subscription

A CorelDRAW® Subscription is an affordable way to
stay up-to-date with the latest tools and
enhancements of CorelDRAW Technical Suite. It offers
a cost-effective alternative to paying the upfront cost
of the software. Instead, you'll get a full, downloadable
version of CorelDRAW Technical Suite* that remains
entirely functional for as long as your subscription is
active. You decide how and when you want to use it.
An annual plan offers an overall discount, with the
option to auto-renew or end your subscription after
the 12-month period. Your subscription entitles you to
the latest performance enhancements and updates. It
also entitles you to the next major version upgrade for
as long as your subscription is active.

Upgrade Protection Program

The CorelDRAW® Upgrade Protection Program is the
hassle-free way for technical illustrators and technical
graphics users to keep their toolbox up-to-date at the
best price. If you own a version of CorelDRAW
Technical Suite with a perpetual license, you pay one
affordable fee once a year, and you're assured of
working with the latest design tools, new file
compatibility, and the most current technology. And as
long as your account is active, you'll automatically get
the latest version of CorelDRAW Technical Suite. Best
of all, sign up once and forget about it. In addition, if
your needs change, you will continue to own the last
version you received through the upgrade program.
The Upgrade Protection Program is also an optional
add-on for the CoreDRAW Technical Suite Single-user
Business license.

Volume License options for teams and organizations

CorelDRAW Technical Suite can also be licensed for
single users, teams and larger groups in an
organization. The CorelIDRAW Technical Suite Single-
user Business license lets companies get individual
licenses that come with the option of adding the
Upgrade Protection Program. The CorelDRAW
Technical Suite Enterprise license allows organizations
to purchase licenses in volume to secure a much lower
overall cost. It includes one year CorelSure Software
Maintenance, which guarantees that customers
automatically receive all new releases during the
lifetime of the program, as well as benefiting from
advanced support and cumulative cost savings if
additional seats are required. What's more, this license
offers enterprises the choice of renewing CorelSure
Maintenance for one or two years. Both options are
available to order from one of our many authorized
resellers.

For more information about the Corel Licensing
program, please visit www.coreldraw.com/business.

* A corel.com account and Internet connection are required to
download and use the application and manage your
subscription.
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Customer profiles

Technical communication
professionals

These users often have formal training in a technical or
graphics field, such as technical illustration or
technical writing. They work in discrete manufacturing,
automotive, aerospace, high tech and
telecommunications, architecture, engineering and
construction (AEC), and apparel industries.

The graphics created by technical illustrators are used
in assembly instructions, user guides, illustrated parts
catalogs (IPCs), maintenance manuals, schematics, or
wiring diagrams. These documents are output to
various media, such as print, the web, mobile devices,
and interactive electronic technical manuals (IETMs).

Technical communication professionals in today’s
global markets need to create technical publications in
multiple languages for a worldwide customer base.
The ability to work seamlessly with Translation
Memory Systems (TMS) used in the localization
workflow is critical to streamline processes.

In addition, many organizations rely on content
authoring and management systems, so they seek
solutions that can be easily integrated. These users
need direct access to Microsoft SharePoint so they can
quickly retrieve and store documents, compare
document versions, and track changes directly from
within their technical graphics software.

Technical graphics users

These users are often self-taught in graphic-creation
tasks and include knowledge workers in medium to
large enterprise environments, such as manufacturing,
automotive, telecommunication, pharmaceuticals,
chemicals, and energy industries.

Among their many tasks and responsibilities is the
need to create a variety of graphics, including
diagrams used in presentation materials, floor plans,
schematics, and marketing materials.

These users may create graphics from scratch or base
them on legacy files. They often work collaboratively,
and the graphics they create may later be imported
for reuse with office-productivity, diagramming, and
desktop-publishing software.

In a typical organization, there may be many technical
graphics users spread across several departments.
They are not generally required to use the software
daily, and as such, they do not often get opportunities
for extensive training.

Organizations require cost-effective and easy-to-use
solutions that enable their users to repurpose legacy
files and 2D CAD data — and eventually 3D CAD data.
They also need tools for creating basic technical
diagrams and publishing standardized outputs.

CorelDRAW

TECHNICAL SUITE 2018

Reviewer's Guide [ 5]






)

What’s included?

Applications

+  Corel DESIGNER® 2018: This specialized
application streamlines the technical graphics
workflow by offering precision vector drawing, .
page layout, and diagramming tools that meet
the demands of technical illustrators and technical
graphics users.

«  CorelDRAW® 2018: This intuitive vector-illustration .
and page-layout application is the perfect partner
for Corel DESIGNER. It offers graphics users
additional creative graphics and design tools that
are ideal for more artful endeavors, such as
marketing collateral outputs.

«  Corel® PHOTO-PAINT® 2018: This professional
image-editing application lets you quickly and
easily retouch and enhance photos for both
technical communication and creative graphics
projects.

¢ XVL Studio 3D Corel Edition: This 3D authoring

and online sources to quickly find the perfect
complement for an illustration. Fully integrated, it
is also available as a docker in Corel DESIGNER,
CorelDRAW, and Corel PHOTO-PAINT.

XVL Player: This 3D viewer is integrated with Corel
DESIGNER 2018 for the insertion of 3D data assets
in technical illustrations. It provides the ability to
modify 3D views and display modes.

Corel CAPTURE™ 2018: This one-click utility lets
you capture images from your computer screen,
which is especially useful for creating illustrated
software documentation, such as user guides.

Corel AfterShot™ 3 HDR: This photo editor lets you
create high dynamic range (HDR) images and
make easy corrections and enhancements to your
RAW or JPEG photos.

BenVISTA PhotoZoom Pro 4: This plug-in lets
registered users export and enlarge digital images
from Corel PHOTO-PAINT.

application lets you create vector illustrations and Supporting applications

photo-realistic renderings from 3D views,
including cross sections and 3D element
modifications, such as the creation of exploded
views.

+  Corel Font Manager™ 2018: This standalone font .
management application lets you find, organize,
and preview local fonts, as well as online fonts on
the Content Exchange.

*  Corel® PowerTRACE® 2018: As an integrated
feature in Corel DESIGNER and CorelDRAW, this
convenient utility lets you quickly and accurately
convert bitmaps, such as scanned blueprints, into :
editable vector graphics.

+  Corel® CONNECT" 2018: This full-screen browser
connects you to the suite’s digital content library,
and lets you search your computer, local network,

Microsoft® Visual Basic® for Applications: This
integrated development environment includes 64-
bit support and helps you streamline your
workflow by automating tasks.

Microsoft® Visual Studio® Tools for Applications:
This toolset includes the power of the NET
framework, so developers can create time-saving
plug-ins and add-ons with Visual Studio to
automate tasks and extend functionality.

Duplexing wizard: This wizard helps you optimize
your work for two-sided printing.

Barcode wizard: This wizard lets you generate bar
codes in a wide range of industry-standard
formats.
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Content

*  More than 4,000 industry-standard Architectural,
Electrical, General, Mechanical, and Tools symbols

«  More than 350 templates, including more than 40
technical ANSI, DIN, and ISO standard templates

+ 10,000 high-quality clipart and images
« 2,000 high-resolution digital photos
+  Over 1,000 TrueType and OpenType® fonts

«  Over 500 interactive frames and photo frames

«  Over 600 fountain, vector and bitmap fills
Documentation

«  Online Help files

e Online User Guides (PDF format)

« Video tutorials

CorelDRAW Technical Suite 2018
system requirements

«  Windows 10, Windows 8.1 or Windows 7, in 32-bit or
64-bit, all with latest updates and service packs

« Intel Corei3/5/7 or AMD Athlon 64
« 2 GBRAM

» 1 GB hard disk space (for typical installation
without content)

«  Multi-touch screen, mouse or tablet

« 1280 x 720 screen resolution at 100% (96 dpi)
« DVD drive optional (for box installation)

»  Microsoft Internet Explorer 11 or higher

*  Microsoft .NET Framework 4.6

* Internet connection*

XVL Studio 3D CAD Corel Edition
(optional Add-on) system requirements

For processing 3D CAD assembly data we
recommend:

«  Microsoft Windows 10, Windows 8.1 or Windows 7
(64-bit editions) with the latest updates and service
pack installed

+ 8 GBRAM or more
« 1280 x 800 or higher screen resolution

« Internet connection required for product
activation and installing updates

XVL Studio 3D Corel Edition is included and installed
with CorelDRAW Technical Suite 2018. The optional
XVL Studio 3D CAD Add-On product unlocks
additional functionality for the integrated application.

*Note: An authenticated version of CorelDRAW Technical Suite 2018
and Internet connection are required to access some of the included
software components, online content and features.
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Key features

CorelDRAW Technical Suite 2018 is a complete and
cost-effective solution for authoring visual
communications for publishing to print, online, and
mobile devices.

Comprehensive

Technical graphics professionals can take advantage of
a full suite of professional applications that covers all
aspects of visual communication authoring, project
creation and publishing of technical documentation.

The integrated workflow provides a seamless
experience, from opening source files, such as 2D, 3D,
photo, documents and data, to supporting output for
print, online and mobile.

In addition, you can leverage all the power and
stability you need to satisfy technical publication
industry standards with support for over 100 data file
formats.

Enhanced! TMS support: Corel DESIGNER 2018 offers
enhanced support for Translation Memory Systems
(TMS), simplifying the creation of technical
documentation for a global market and reducing
localization costs. Now you can format text spanning
multiple columns. You can export text with language
codes used by translation programs to the XML
Localization Interchange file format (XLIFF), the
industry-standard format for sharing translatable text
between a TMS and software. The translated text you
receive back maintains the original formatting, so you
can create a language-specific file with identical
content and formatting, except the translated text
strings. Using the layer structure available in Corel
DESIGNER documents, you can create multilingual
documents by importing translated text into copies of
the original text.
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Corel DESIGNER simplifies the creation of technical
documentation for a global market.

New! Straighten photos interactively: The new
Straighten tool in Corel PHOTO-PAINT lets you rotate
crooked images by interactively aligning a
straightening bar to an element in the photo or
specifying an angle of rotation. All the controls are
easily accessible on screen or on the property bar. You
can choose to rotate the image horizontally, vertically,
or just let Corel PHOTO-PAINT decide which
straightening mode works best. The Straighten tool
can also rotate lenses, masks, objects, and groups of
objects. In addition, you can crop the photo as you
align it, or choose not to crop it and fill the edges with
the background color instead.
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You can interactively correct crooked shots with the Straighten
tool.

Click here to see how it works.
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New! Correct photo perspective interactively: Corel
PHOTO-PAINT 2018 has a new interactive feature that
gives you the power and versatility of an expensive tilt
correction lens. With the Perspective Correction tool,
it's easy to correct the perspective of landmarks or
objects in photos to get the exact look that you
wanted. Right in the image window, you simply move
the four corner points to get the perspective that you
have in mind. You can also display grid lines that make
it easy to apply the rule of thirds as you adjust
perspective.

_ N
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In a couple of clicks, you can adjust perspective interactively.
Click here to see how it works.

New! AfterShot 3 HDR: You can download Corel
AfterShot 3 HDR at no extra cost from within Corel
DESIGNER, CorelDRAW or Corel PHOTO-PAINT, and
quickly learn professional-grade photo editing. It lets
you make easy corrections and enhancements to your
RAW or JPEG photos, and apply adjustments to
thousands of photos in a click with batch-processing
tools. Plus, you can create high dynamic range (HDR)
images with the HDR module, included in AfterShot 3
HDR.

Enhanced! CGM support: Corel DESIGNER delivers
increased support for CGM files, an industry-standard
format critical to a range of sectors, including aerospace,
defense and automotive. Technical illustrators have
complete control when outputting a drawing to a CGM
file. More CGM V4 profiles are supported, including
S1000D (2.3, 3.0, 4.0, 4.1 and new 4.2) and ATA
GREXCHANGE (2.8-2.12) for ATA iSpec 2200.

Enhanced! DWG/DXF support: Corel DESIGNER has
enhanced support for the latest DWG version when
importing files, including documents created with
AutoCAD 2018 and AutoCAD 2019.

New! SharePoint integration: CorelDRAW Technical
Suite 2018 delivers more collaboration and sharing
options. With CorelDRAW Technical Suite 2018
Enterprise licenses or CorelDRAW Technical Suite
licenses with CorelSure Maintenance, you now can
have direct access to Microsoft SharePoint, so you can
quickly retrieve and store documents, compare
document versions, and track changes directly from
within Corel DESIGNER or CorelDRAW.

Microsoft SharePoint integration offers versatile
document management by allowing for storage of
multiple iterations of a file, ensuring accurate tracking
of changes and easy retrieval of previous versions. It
also gives organizations a flexible way to manage
project calendars, to-do lists, and time lines.

Enhanced! Vector previews: CorelDRAW Technical
Suite 2018 boosts your productivity with faster
rendering of tool previews; curve previews, nodes, and
handles; effect controls and sliders; and text. You can
also open large files quicker and enjoy smoother
editing of complex curves. In addition, you can work
more efficiently thanks to tool and object previews
that are more visible and user-friendly.

Enhanced! Work faster with text and fonts: Faster
rendering of text helps accelerate the technical-design
workflow. What's more, the performance of the Font
List in Corel DESIGNER and CorelDRAW 2018 has been
enhanced so you can quickly find what you're looking
for.

Enhanced! Work faster with fonts stored on a
network: Finding the right font for the job is easier
than ever thanks to enhancements to Corel Font
Manager that improve monitoring fonts stored on a
network.

New! Warning when can't embed fonts: Another time-
saver is a new warning that appears when you save a
file listing any fonts that can't be embedded. This
simplifies collaborative workflows by identifying any
fonts that a colleague will need to continue working
on the document.

[ 10 ] Reviewer's Guide
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New! Filter fonts based on embedding rights: You can
save time and ensure hassle-free file sharing thanks to
the new Embedding Rights font filter. It allows you to
sort fonts based on four common font-embedding
permissions, so you know right from the outset which
fonts to use or avoid when choosing text styles. The
filter gives you a quick idea of what other users will be
able to do with text and fonts in a design that you share
with them. You'll be able to see which fonts can't be
embedded or which ones recipients of the drawing can
install on their computer, allow for text editing, or can
be only viewed and printed.

New! File Save indicator: If you work on multiple
documents simultaneously in Corel DESIGNER,
CorelDRAW and Corel PHOTO-PAINT, it's now easier
to see which files contain unsaved changes. An
asterisk appears next to the name of unsaved files on
the Windows menu, the title bar and the document
tab, so you can identify the status of your work in a
glance.

h ﬁ Loremlpsum_1.des* Loremlpsum_2.des
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In a glance, you can see what files have unsaved changes.

New! Apply and manage fills and transparencies: How
users interact with design assets has undergone a
complete overhaul in CoreIDRAW Technical Suite 2018.
Totally redesigned Fill and Transparency pickers help
boost your productivity and deliver improved
performance when working with and managing fills
and transparencies in Corel DESIGNER, CorelDRAW,
and Corel PHOTO-PAINT. A streamlined Ul allows you
to use, create, and find fills and transparencies faster
than ever. You can download new content packs, add
your own library, easily migrate an asset collection
anywhere, and modify asset properties — all within
the suite. In addition, you can use aliases to view
content stored in another folder on your computer, a
USB flash drive, or a shared network folder.

To easily find fills and transparencies you use often,
simply mark them as favorites. To avoid clutter, you
can move unused assets to a new folder or delete
them. Locating the asset you want is a snap. You can
view a list of your favorite or most recently used fills
and transparencies. You also can search and browse
one pack, folder or list at a time. And if you are
looking to expand your fill collection, you can
download additional fill packs from within the Get
More dialog box.
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e

More flexible asset management enhances design productivity.

New! Block Shadow tool: The Block Shadow tool in
Corel DESIGNER lets you add solid vector shadows to
objects and text. This intuitive feature accelerates
reprographic workflows by greatly reducing the
number of lines and nodes in shadows, slashing the
time it takes to get a file ready for output and vastly
improving the final result. Powerful property bar
settings let you specify the exact depth and direction
of the shadow, or you can manipulate those properties
interactively within the drawing to get the look that
you have in mind. This feature is also available in
CorelDRAW 2018.

New! Project Timer: Corel DESIGNER 2018 has a new
tool designed to help technical graphics professionals
keep organized, properly bill clients, and provide
insight into how they work. The Project Timer is an
accurate, non-intrusive way to track time spent on a
project. Appearing as a discreet toolbar above the
drawing window, the Project Timer is fully
customizable to match your workflow. It offers a
variety of ways to monitor and record tasks and
project details. Tracking information is saved with the
document and can be exported to file formats that
can be opened in spreadsheet applications to create
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time sheet reports. This feature is also available in
CorelDRAW 2018.

New! Default folder locations: To simplify finding and
sharing technical design assets, you can choose where
to store content rather than use the default folders. In
response to user requests, Corel DESIGNER,
CorelDRAW and Corel PHOTO-PAINT now let you
customize where fills, fonts, image lists, photo frames,
templates and trays are stored, including any that
you've created or acquired from online content
providers.

Enhanced! XVL Studio 3D Corel Edition: Core|DRAW
Technical Suite 2018 includes XVL Studio 3D Corel
Edition, a 3D-authoring application that lets you open,
edit, and modify 3D models and import 3D views into
your technical illustrations New default illustration-
output settings deliver significantly more accurate
vector illustration outputs of 3D views. The illustration
specifications, such as view, positions of the objects,
line weights and export settings, are fully recognized
and maintained. In addition, the new Update
Illustration tool streamlines the process for updating
vector illustrations sourced from a 3D view after
modification of the 3D model or view.

You can also create vector illustrations and photo-
realistic renderings from 3D views and send them to
Corel DESIGNER or CorelDRAW, where you can import
3D models as 2D vector graphics to your drawings.
You can also import IGES files, a 3D CAD exchange
format that supports solid geometries.

In addition to transforming 3D views to vector
graphics for technical-illustration authoring in Corel
DESIGNER, you can also send an active 3D view in XVL
Studio Corel Edition to CorelDRAW. The vector
graphics output from XVL Studio can then be used as
source files for the creation of marketing collateral and

other creative deliverables based on engineering data.

File format compatibility: Corel DESIGNER has
support for the latest versions of two formats widely
used in technical publications, WebCGM and SVG,
ensuring that you can easily exchange files with
colleagues and clients worldwide and produce a range

of downstream outputs. Corel DESIGNER also offers a
range of PDF options, including publishing your
document as a 3D PDF or to the ISO compliant PDF/A
archiving format. In addition, if a PDF that you're
importing contains objects that fall outside the
drawing page, you can now leave them intact or crop
them to the drawing page. You can import from and
export to more than 100 file formats, including EPS,
DWG, TIFF, PNG, JPEG. What's more, files saved in the
Al or PSD file format can be easily imported to Corel's
ecosystem where work can continue without missing a
beat.

3D PDF support: You can publish technical drawings to
3D PDF from Corel DESIGNER 2018, giving you the
power to create documents that combine text, vector
graphics, images, and embedded 3D models. Using a
PDF reader that supports 3D PDF viewing, the end
user can interact with the 3D model. They can
intuitively rotate, move and size it, access assembly
and part structure information, and take a look inside
a 3D model by displaying cross-sections.

3D PDF is an excellent cross-media format. In addition
to being ideal for electronic distribution, it can also be
used for print, with the 3D content being printed in its
default view.

Step-by-step assembly

You can create 3D PDFs.
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Object Styles: This productivity-enhancing feature
ensures a consistent visual style in technical
publications, making it easy to comply with military
and civil aerospace standards, such as S1000D and ATA
iSpec 2200. Object styles lets you edit a style or a style
set once and have the changes applied instantly
throughout a project.

Color Styles docker: The Color Styles docker lets you
use styles and color harmonies to manage colors and
quickly implement project-wide color changes, which
is especially useful for producing iterative designs and
varying graphic outputs. The Color Styles docker also
offers convenient View Options, including Hint View,
which provides a visual indication of all document
objects that use a specific color style, and Page Sorter,
which displays thumbnails of all pages in a multi-page
document and previews changes as you adjust colors.

Precise

You can apply exacting specifications using dedicated
technical illustration tools to design visually detailed
assembly instructions, complex user manuals and
multi-faceted documentation.

New! Align and distribute nodes: Since it was
introduced, the Align and Distribute docker has
become an indispensable tool for technical graphics
professionals because of the quick and easy access it
offers to time-saving controls for positioning objects.
In Corel DESIGNER 2018, those same precise
alignment options can now be used for nodes. What
used to be a slow, manual process can be achieved
effortlessly in a few clicks. You can align nodes using
the bounding box of a selection, the page edge or
center, the closest grid line, or a specified point.
What's more, you can align nodes from different
curves. Distributing nodes is just as easy. You can add
equal spacing between them horizontally or vertically
using the drawing page or a bounding box as the
reference point. This feature is also available in
CorelDRAW 2018.
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The active nodes in a curve (top left) are aligned to the left (1),
right (3), top (4), bottom (6), and along a vertical (2) and horizontal
(5) axis relative to the bounding box of the selection.

Click here to see how it works.
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Give it a try

Aligning nodes

1 Open the sample file Align Nodes.des.
2 Click Window » Align and Distribute to open
the Align and Distribute docker.

3 In the toolbo, click the Pick tool K , and click the
top callout.

4 Press Shift + S to activate the Shape tool Q‘, hold
down Shift, and click node at the tip of each
callout.

5 Inthe Align and Distribute docker, click the
Specified point button in the Align nodes to
area, then click the Specify point button @'.

6 Click the a node on a portion of the belt facing the
callouts to set an alignment reference point.

7 Inthe Align and Distribute docker, click the Align

left button =,

The callout tips align with the belt.

New! Corner controlin dashed lines and outlines: Corel
DESIGNER 2018 give you more control over the
appearance of corners in objects, text, and symbols
that use dashed lines. In addition to the existing
default setting that renders dashed lines exactly as
drawn, you can choose from two new options to
create perfectly designed and defined corners. The
Align dashes option ensures that there’s no empty
space in the corners and at the start and end of a line
or outline by aligning dashes with the end and corner
points. And the Fixed dashes option creates dashes in
the end and corner points that are half the size of the
first dash in the line pattern. This feature is also
available in CorelDRAW 2018.
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New options give you more control on the appearance of corners
in dashed lines: default dashes (left), aligned dashes (center), or
fixed dashes (right).

New! Fit objects to a path: In Corel DESIGNER 2018, you
can fit any type and number of objects to a path of
your choice. Smart spacing and rotation settings help
you customize the arrangement of objects along the
path. This feature is also available in CorelDRAW 2018.

You can easily fit objects to any path to simplify the creation of a
range of technical designs.

Click here to see how it works.

Give it a try

Fitting objects to a path
1 Open the sample file Objects to Path.des.

2 Click Window » Fit Objects to Path to open the Fit
Objects to Path docker.

3 In the toolbox, click the Pick tool \ ,and click a
tooth on the toothed belt in the top-left of the
drawing.

4 In the belt and pulley assembly, click the curve that
represents the belt in the bottom-left area of the
assembly.

5 In the Fit Objects to Path docker, enable the Keep
originals and Group all objects check boxes, and
type 80 in the Duplicate(s) box.

6 In the Origin area, click the top-center option, and
click Apply.
The belt on the bottom-left assembly has 80 belt
teeth fitted to it.

7 Using the Pick tool, click a tooth on the toothed
belt in the top-left of the drawing.
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8 In the belt and pulley assembly, click the curve that
represents the belt in the top-right area of the
assembly.

The settings used for fitting the tooth to the first
path will be re-used with the exception of the
number of duplicates.

9 Type *2 immediately after 80 in the Duplicate(s)
box (80*2) to double the number of duplicates
being fitted to that path, and click Apply.

The belt on the top-right assembly has 160 belt
teeth fitted to it.

Projected drawing: You can intuitively create new
objects and edit existing ones using the dimensions
and coordinates of the active projected plane. The Ul
displays the projected-plane values that you'd expect,
so you can accurately draw, move, copy, stretch, and
scale objects, giving you increased precision and
productivity when authoring isometric drawings.

You can draw and edit using the scale of the projected axes
according to the settings of the active projected plane.

Symbol Manager docker: Technical illustrators often
use symbols for standard drawing components, which
can appear multiple times in an illustration. To that
end, the Symbol Manager docker simplifies creating,
editing, and managing symbols, including custom
defined symbol libraries. Corel DESIGNER 2018 also
offers over 4,000 technical symbols, helping you
quickly add precise detail to technical illustrations.

Innovative

Technical graphics users can explore groundbreaking
tools for sketching and illustration, stay on the cutting-
edge of graphics technology, and advance your
design talents using state-of-the-art tools, including
intuitive photo editing features.

New! Symmetry: Corel DESIGNER 2018 introduces the
Symmetry drawing mode, which boosts your
productivity by automating what is usually a very
time-consuming process. It lets you create a range of
symmetrical designs, from simple objects to complex
kaleidoscopic effects, in real time.

G

There are two ways to use Symmetry mode. You can
work in Symmetry mode from the outset and start
drawing symmetrically immediately. Or, you can apply
symmetry to an existing object or group of objects,
both vector and bitmap.

Symmetry mode can be used with curves, shapes,
objects, text, and you can use transparency, fills and
more in a symmetrical designs.

You can add symmetry lines, adjust the reflection
angle, and move symmetry lines independently of the
objects in the group. And when you edit the original
image or add new nodes or objects, you'll see the
changes repeated and reflected in each copy. This
feature is also available in CorelDRAW 2018.

Click here to see how it works.
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Give it a try

Drawing in Symmetry mode
1 Open the sample file Symmetry.des.
2 On the Drawing Plane toolbar, click the Front

button e so that the drawing plane is bounded by
the x and y axes.
The Drawing Plane toolbar appears to the right of

the standard toolbar.
You can hide or display the grid by pressing F10.

3 In the toolbox, click the Ellipse tool ,JOEl and click
an intersection of the drawing plane axes inside the
circle on the outside of the pulley, and drag to
create an ellipse.

4 Right-click the ellipse, and choose Create New
Symmetry.

A symmetry line appears in the drawing window,
and the ellipse is duplicated and mirrored.

5 Drag the symmetry line over the intersection of the
x and y axes that appears over the nut in the center
of the circle on the outside of the pulley.

The duplicated ellipse is moved relative to the new
position of the symmetry line.

6 On the property bar, type 3 in the Mirror line box
to increase the number of symmetry lines.
This increases the number of duplicates of the
ellipse to 5.

7 Right-click a symmetry line, and choose Finish
Editing Symmetry to exit Edit Symmetry mode.

8 Click off the drawing page, then right-click in the
area where the ellipses were created, and choose
Edit Symmetry.

9 Using the Pick tool \ , select the original ellipse.

10 Hold down the mouse button, and drag while
holding down the right mouse button.

A plus sign (+) appears to indicate that you are
dragging a copy.

11 Position the copy of the ellipse near the intersection
of the symmetry lines, staying within the section
bounded by the lines for the original ellipse, and
release the mouse button.

12 Drag another copy of the original ellipse to the left,
staying within the section bounded by the lines for
the original ellipse.

The copies of the ellipse are mirrored in all areas of
the symmetry group.

13 In the toolbox, click the 2-Point Line tool f click

the Tangential 2-point line button Cj on the
property bar and draw lines to connect the edges
of the original ellipse and its two copies. The line
automatically starts as a tangent to the snapped-to
projected ellipse. Pressing T as you draw snaps the
end point of the line to the outside edge of the 2nd
projected ellipse.

The lines connecting the ellipses are mirrored in all
areas of the symmetry group.

14 In the toolbo, click the Virtual Segment Delete

tool m°, move the pointer over the original ellipse,
and click when the cursor snaps upright.

15 Repeat for the copies of the ellipse.

The deletion of the interior segments of the
ellipses is mirrored in all areas of the symmetry

group.

Enhanced! LiveSketch tool: The LiveSketch tool has
quickly become a favorite with technical illustrators
because it gives them the ability to design using hand-
drawn vector curves right from the get-go. And in
Corel DESIGNER 2018, this revolutionary tool has been
enhanced. How the application analyzes and adjusts
your input strokes has been refined, delivering results
that are more predictable than ever. You can harness
this enhanced accuracy to speed up your workflow
and focus on the design process, making it even easier
to get an idea onto the screen in front of you. This
enhancement is also available in CoreIDRAW 2018.

You can capture design concepts using hand-drawn vector
curves.
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New! Publish to WordPress: In Corel DESIGNER 2018,
you can send your work directly to a WordPress media
library from within the application. This new
functionality enables you to convert selected objects
or an entire project to a JPEG, GIF, or PNG file and
then upload the image to a WordPress account —
without ever leaving Corel DESIGNER. If you have
multiple WordPress sites or accounts, you can easily
specify where your content is uploaded.

You can also publish images to WordPress from
CorelDRAW 2018 and Corel PHOTO-PAINT 2018.

New! GPU accelerated vector previews: Repositioning
and editing complex vector shapes can tax your
system’s resources, especially when previews are
displayed. By default, the central processing unit (CPU)
of your computer is used to generate vector previews,
but you can now opt to use the graphics processing
unit (GPU) instead. The GPU is a specialized processor
that greatly accelerates the display, editing, and
manipulation of graphics. Choosing to use the GPU
delivers faster rendering of tool previews, curves, and
other effects in Corel DESIGNER, CorelDRAW, and
Corel PHOTO-PAINT. Since GPUs vary across
machines, these enhancements may be more
noticeable to some users than others.

New! HDR merge: You can now access the High
Dynamic Range (HDR) Merge module in AfterShot 3
HDR directly from the Camera RAW Lab in Corel
PHOTO-PAINT 2018 to combine two or more photos
of the same scene that were taken with different
exposure settings. This lets you access a broader tonal
range to create a final image.

New! Flip the stylus pen to eraser: If you work with a
pen or stylus, you can take advantage of a variety real-
time input factors to erase with the ease and accuracy
of a pencil eraser. Now in Corel DESIGNER, you can
use pressure to vary the size of the eraser nib, as well
as link tilt and bearing to its flatness and rotation.
Flipping the stylus or pen activates the Eraser tool, so
you can erase on the fly without having to go to the
toolbox. In addition, you can use the Eraser tool on
most object types, and it's easier to erase through

groups of objects. This feature is also available in
CorelDRAW 2018.

Enhanced! Support for wheel devices: CorelDRAW
Technical Suite 2018 offers alternative ways of working
thanks to enhanced support for wheel devices, such as
the Microsoft Surface Dial. Put your keyboard aside
and take advantage of the contextual onscreen Ul.
Design more naturally using a combination of
ergonomic tools such as wheel devices, touch, or a
stylus. This workflow lets you easily switch between
tools and tasks with the non-dominant hand as you
sketch or design with the other.

Improved wheel support ensures that you can do more with
peripheral devices.

New! Add Perspective effect: Corel DESIGNER 2018
gives you the ability to use the Add Perspective effect
on bitmaps with the same ease that you've always had
when applying it to vector objects. It's never been
easier to create the illusion of distance and depth by
applying perspective to bitmaps, vector objects, or
both simultaneously. You can work with speed and
precision because you apply it interactively right in the
drawing window. The Add Perspective effect is a great
tool for technical graphics users who want see what a
design will look like in real world scenarios, such as
brochures, packaging, exhibition booth panels, and
more. The effect is applied non-destructively, so you
can edit it or remove it and revert to the original
image at any point. This feature is also available in
CorelDRAW 2018.
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You can interactively tailor the perspective effect.

Click here to see how it works.

Give it a try

Adding Perspective and Envelope effects nodes
1 Open the sample file Perspective.des.
2 In the toolboy, click the Pick tool R, and click the

wordmark (Tooth Belt company) in the bottom-right
of the drawing.

3 Press Ctrl + C to copy it, Ctrl + V twice to create
two copies.

4 Drag one copy to left edge of the belt.
5 In the Interactive Tools flyout in the toolbox, click
the Envelope tool ¥.X.

6 Drag the nodes to interactively shape the
wordmark to contours of the left edge of the belt.

7 Drag the second copy to below the bottom-right
edge of the belt.

8 Click Effects » Add Perspective.

9 Drag the nodes on the outside of the grid to align
the edges of the wordmark with the shape of the
belt.

Enhanced! Apply envelopes to bitmaps: Corel
DESIGNER 2018 gives you the same ability to
interactively shape bitmaps that you've always had
when working with vector objects. You can quickly and
seamlessly blend a bitmap into an illustration using
envelope presets, or you can craft one from scratch
and save it for reuse. The enhanced Envelope tool can
be used on a group of objects, whether vector, bitmap
or both — all non-destructively. All the controls that
you need are right on the canvas and property bar, so
there’s no time spent navigating a series of dialog
boxes. Technical designers can quickly swap out the
bitmaps used in an envelope with the Copy envelope
properties option, so experimenting and getting the
perfect look is effortless. What's more, you can turn
any vector object into an envelope with the Create
envelope from option. This enhancement is also
available in CorelDRAW 2018.

The original bitmap (top) with an envelope (bottom). The
envelope is applied nondestructively, so you can edit it or remove
it and revert to the original image at any point.

Click here to see how it works.

QR codes: With Corel DESIGNER 2018, you can add
scalable QR codes to a drawing, allowing you to give
technicians in the field the ability to access online
technical documentation from printed documentation
or machine labels using a smartphone. It's easy to
customize a QR code and analyze it to ensure it can

[ 18 ] Reviewer's Guide

CorelDRAW

TECHNICAL SUITE 2018


https://www.coreldraw.com/cdts2018samples
https://corl.co/AddPerspective
https://corl.co/ApplyEnvelopes

be read by QR code readers, mobile devices, and
scanners.

Multiple document interface: You can work with
multiple documents in a tabbed view, which helps you
stay organized and quickly switch between several
active documents.

(&) Corel DESIGNER 2018 (64 Bit) - Symmetry.des*
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You can easily work on multiple documents simultaneously.

Content Exchange: The Content Exchange is an online
repository that integrates with Corel CONNECT and
the suite’s applications, making it quick and effortless
to access and share vector fills, bitmap fills, and
fountain fills with a community of other users. You can
instantly set any asset that catches your eye in the
Content Exchange as a favorite, which is a quick and
convenient way to keep a list of content that you
might want to download later.

Transparency: You can apply transparency to
individual color nodes within a fountain fill, allowing
you to adjust an object's transparency so that all
objects beneath it are partially visible.

Transparency settings are accessible in the Property
Manager docker in Corel DESIGNER 2018 (and the
Object Properties docker in CorelDRAW 2018), making
it fast and easy to apply and adjust object
transparency.

Property Manager
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Itis fast and easy to apply and adjust object transparency.
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Advanced 3D CAD repurposing: XVL Studio 3D
CAD Corel® Edition (optional add-on)

For organizations that require additional 3D editing
capabilities and direct access to 3D CAD assembly
files, CoreIDRAW Technical Suite 2018 offers an
upgrade to XVL Studio 3D CAD Corel Edition. This
add-on provides native assembly and part file support
for 3D CAD systems used in discrete manufacturing,
such as the automotive, aerospace, and machinery
industries. XVL Studio 3D CAD Corel Edition lets users
do more with CAD files without the steep learning
curve of 3D CAD software. It streamlines the workflow
of technical communication professionals by reducing
the need to consult design engineers when preparing
graphics content.

Enhanced! File support: XVL Studio 3D CAD Corel
Edition supports a broad range of native 3D CAD file
formats. such as assembly and part files from CATIA,
SolidWorks, PTC Creo Parametric (formerly Pro/
ENGINEER), Autodesk Inventor, NX, SolidEdge, and
more. It also supports 3D CAD exchange formats, such
as JT, IGES, STEP, and Parasolid. File import support
has been updated to include CATIA V5-6R2018,
Autodesk Inventor 2018, NX 12, Solid Edge ST10,
SolidWorks 2018.

Enhanced! 3D CAD file options: You can send multiple
3D views to Corel DESIGNER as vector illustrations in
one go. What's more, you can resend newer versions of
views stored as snapshots to update existing
illustrations in a DES file. The new Process Snapshot
feature simplifies the capturing and illustration of
assembly and maintenance processes. You can also
take advantage of enhanced annotation features and
dimension tools. You also have the flexibility of adding

specific options from the standalone version of XVL
Studio, such as the Process PDF Template option, to a
XVL Studio CAD Corel Edition license.

Enhanced! XVL Studio 3D Corel Edition: New default
illustration-output settings deliver significantly more
accurate vector illustration outputs of 3D views. The
illustration specifications, such as view, positions of the
objects, line weights and export settings, are fully
recognized and maintained. In addition, the new
Update Illustration tool streamlines the process for
updating vector illustrations sourced from a 3D view
after modification of the 3D model.

Enhanced! XVL Studio 3D CAD Corel Edition: This
optional add-on delivers a variety of productivity
enhancements. When sending a snapshot to Corel
DESIGNER, you can specify which parts will be
outlined, significantly reducing file size. You can also
align notes to a specified link. The new Selection
Process view displays only parts that you specify, so
you can easily compare the selected parts to the entire
model view. To simplify managing assemblies, you can
highlight ones that aren't registered in the
Manufacture and Process trees, reducing the chance
of having missing parts. And when you're publishing
to Microsoft Excel, you can customize the size of
images in the report.
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Update / replace assembly functionality:

Once a design moves to the production phase,
construction changes are common. With XVL Studio
3D CAD, you can update early designs at any time due
to changes determined by construction. Disassembly

views, animations, and other 3D authoring functions
are maintained, so that you can efficiently update
technical illustrations with the most current revision of

the manufacturing design.

The update or replace assembly functionality offered by XVL Studio 3D CAD Corel Edition
helps you ensure that the most current manufacturing revisions are reflected at any time in the visualization workflow.

Update a 3D-sourced illustration: To speed up
technical-publication authoring, CorelDRAW Technical
Suite 2018 with XVL Studio 3D CAD Corel Edition
offers the Auto Detection and Update command. It
updates 3D visualizations created in XVL Studio CAD,
stored snapshots, cross-sections and animated
procedures — including process animations for
illustrating complex, multi-step assembly, disassembly,
or maintenance procedures — based on the
modifications applied to the CAD source data. New
selection, review and filter options in the auto
detection and update process automatically apply
modifications in Engineering files to all visualizations
created for technical communication.

It also lets you automatically generate updated vector
illustrations to replace ones in DES files that were
created using the Send to Corel DESIGNER command.
The illustration specifications, such as view, positions
of the objects, line weights and export settings, are
fully recognized and maintained. As a result, the
illustrations are recreated using the updated 3D model
and inserted in the same place as the original,
allowing technical illustrators to start a publication

with a preliminary 3D design and update it with the
final design instantly.

You can automatically update 3D-sourced illustrations.

Evaluation tools: Before 3D models and data can be
used in downstream applications, the integrity of the
3D model requires validation. XVL Studio 3D CAD
provides assembly evaluation tools for geometry and
measurements, interference check, and collision
detection so you can quickly verify the integrity of a
3D assembly.
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Additional 3D CAD tools: With XVL Studio 3D CAD, you
can edit 3D models and combine 3D models from
different CAD sources. It provides a rich 3D CAD
toolset that lets you modify and transform 3D parts,
shapes, and assemblies.

Enhanced! Animation tool set: XVL Studio 3D CAD
provides a full set of animation tools, including a
dedicated editing console as well as a method for
automated creation of disassembly animations.
Process animations can be created to capture
complex, multi-step assembly or maintenance
procedures with detailed instructions. And new
options make it easier than ever to edit process
animations. The hierarchical structure of the Assembly
Tree view and the ability to create custom tree
structures for disassembly and process animations
gives you full control over the creation of assembly,
sub-assembly, and part structures for use in illustrated
assembly and maintenance instructions.

Display Duration =

Online and mobile outputs: XVL Studio 3D CAD
supports output of 3D models to HTML5 and for
mobile devices. By using the highly compressed XVL®
file format, you can share complex models with

virtually anyone, using the free XVL Player as browser
plug-in for desktop/laptop or iXVL apps for iOS. XVL is
the most lightweight 3D format in the industry,
enabling data to be compressed to an average 0.5% of
its original size with high accuracy. For example, a 500
MB 3D CAD assembly file can be shared on mobile
devices as an XVL file with an approximate file size of
2.5 MB.

3D outputs: With XVL Studio 3D CAD Corel Edition,
you can output to various 3D file formats, including
3DS, DXF, IGES, OBJ, STL, U3D, and VRML. You can also
publish directly to 3D PDF from XVL Studio CAD Corel
Edition, using a PDF template with animation controls.
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